but you can find out the Alt menu shortcut in your
language by looking at which letters are underlined on the relevant menus.

Where the 'Vrsn' column shows <9>.", the command is only supported in Word 2000 and above
Most - but NOT all - of the shortcuts are language-independent. In particular, most of the Alt menu shortcuts are NOT;

Word Command Description Version Menu Shortcut
AllCaps Makes the selection all capitals (toggle) Ctrl + Shift + A
ApplyHeadingl Applies Heading 1 style to the selected text Alt+ Ctrl +1
ApplyHeading2 Applies Heading 2 style to the selected text Alt+ Ctrl +2
ApplyHeading3 Applies Heading 3 style to the selected text Alt+ Ctrl +3
ApplyListBullet Applies List Bullet style to the selected text Ctrl + Shift + L
AppMaximize Enlarges the application window to full size Alt + F10
AppRestore Restores the application window to normal size Alt + F5
Bold Makes the selection bold (toggle) Formatting toolbar Ctrl+B
BottomAlign Aligns cell content to the bottom of cell - very useful and Word 97 right-click menus
unfortunately, not accessible via the default Word 2000. menus. It is and Word 97 Tables and
well worth replacing the Word 2000 Cell Alignment buttons on the Borders menu
right-click table menus and on the Tables and Borders toolbar, with
BottomAlign, CenterAlign and TopAlign buttons. The Word 2000
buttons, unfortunately, apply manual left center or justified
paragraph formatting to the text in the cells, which is the last thing
you would ever want to happen!
BottomCenterAlign Aligns cell content to the bottom-center of cell (yuckk!!) <9> |Word 2000 right-click
menus and Word 2000
Tables and Borders menu
BottomLeftAlign Aligns cell content to the bottom-left of cell (yuckk!!) <9> |Word 2000 right-click
menus and Word 2000
Tables and Borders menu
BottomRightAlign Aligns cell content to the bottom-right of cell (yuckk!!) <9> |Word 2000 right-click
menus and Word 2000
Tables and Borders menu
BrowseNext Jump to the next browse object Double-down-arrow Ctrl + PgDn

below vertical scrollbar




Word Command

Shortcut

Description

BrowsePrev Jump to the previous browse object Double-up-arrow below |Ctrl + PgUp
vertical scrollbar

BrowseSel Select the next/prev browse object Alt + Ctrl + Home
Cancel Terminates an action Esc
CenterAlign Aligns cell content to the center of cell - very useful and Word 97 right-click menus

unfortunately, not accessible via the default Word 2000. menus. It is and Word 97 Tables and

well worth replacing the Word 2000 Cell Alignment buttons on the Borders menu

right-click table menus and on the Tables and Borders toolbar, with

BottomAlign, CenterAlign and TopAlign buttons. The Word 2000

buttons, unfortunately, apply manual left center or justified

paragraph formatting to the text in the cells, which is the last thing

you would ever want to happen!
CenterPara Centers the paragraph between the indents Formatting toolbar Ctrl+E
ChangeCase Changes the case of the letters in the selection Shift+F3
CharLeft Moves the insertion point to the left one character Left arrow
CharLeftExtend Extends the selection to the left one character Shift + Left arrow
CharRight Moves the insertion point to the right one character Rt arrow
CharRightExtend Extends the selection to the right one character Shift + Rt arrow
CheckBoxFormField Inserts a check box form field Forms toolbar
ClosePane Closes the active window pane (if you are in Normal View and Close button on the Alt + Shift + C

have, for example, the Footnote pane open) relevant panes
ColumnSelect Selects a columnar block of text Alt+Drag (or press Ctrl +

Shift + F8 and drag, but Alt
+ Drag is far easier!)

ConvertTextBoxToFrame Converts a single selected textbox into a frame Rt-click
CopyFormat Copies the formatting of the selection Ctrl +Shift+C
CopyText Makes a copy of the selection without using the clipboard (press Shift + F2

Return to paste)
CreateAutoText Adds an AutoText entry to the active template Alt + F3
DecreaseIndent Decreases indent or promotes the selection one level Formatting toolbar
DeleteBackWord Deletes the previous word without putting it on the Clipboard Ctrl+ Backspace
DeleteWord Deletes the next word without putting it on the Clipboard Ctrl + Del




Word Command

Description

Version

Shortcut

DistributeColumn Evenly distributes selected columns or all columns if none selected Table menu
DistributeRow Evenly distributes selected rows Table menu
DocClose Prompts to save the document and then closes the active window. Ctrl+W, Ctrl+F4
(But doesn’t intercept the menu command)
DocMaximize Enlarges the active window to full size Ctrl + F10
DocMove Changes the position of the active window Ctrl + F7
DocRestore Restores the window to normal size Ctrl + F5
DocSize Changes the size of the active window Ctrl + F8
DocSplit Splits the active window horizontally and then adjusts the split Window menu Alt+Ctrl +S
DoFieldClick Executes the action associated with macrobutton fields Alt + Shift + F9
DotAccent Formats the selection with dot accents (toggle) <9> |Word 2000 Extended
Formatting toolbar
DoubleUnderline Double underlines the selection (toggle) Word 2000 Extended Ctrl + Shift + D
Formatting toolbar
DrawAlign Aligns the selected drawing objects with one another or the page Draw menu
DrawBringForward Brings the selected drawing objects forward Draw menu
DrawBringToFront Brings the selected drawing objects to the front Draw menu
DrawGroup Groups the selected drawing objects Draw menu AltR, G
DrawNudgeDown Moves the selected drawing objects down Down arrow
DrawNudgeLeft Moves the selected drawing objects to the left Left arrow
DrawNudgeRight Moves the selected drawing objects to the right Right arrow
DrawNudgeUp Moves the selected drawing objects up Up arrow
DrawSendBackward Sends the selected drawing objects backward Draw menu
DrawSendToBack Sends the selected drawing objects to the back Draw menu
DrawSnapToGrid Sets up a grid for aligning drawing objects Draw menu AltR, 1
DrawTextBox Inserts an empty textbox or encloses the selected item in a textbox Drawing toolbar
DrawUngroup Ungroups the selected group of drawing objects Draw menu AltR, U
DropDownFormField Inserts a drop-down form field Forms toolbar
EditBookmark Brings up the bookmark dialog Insert menu Ctrl+Shift+F5 (Or: Alt I, K)




Word Command

Shortcut

Description

EditClear Performs a forward delete or removes the selection without putting Edit menu Del
it on the Clipboard
EditCopy Copies the selection and puts it on the Clipboard Edit menu & Standard Ctrl+C
toolbar
EditCut Cuts the selection and puts it on the Clipboard Edit menu & Standard Ctrl+X
toolbar
EditFind Finds the specified text or the specified formatting Edit menu Ctrl+F
EditGoTo Jumps to a specified place in the active document Edit menu F5, Ctrl+G
EditLinks Allows links to be viewed, updated, opened, or removed Edit menu AltE, K
EditPaste Inserts the Clipboard contents at the insertion point Edit menu & Standard Ctrl+V
toolbar
EditPasteSpecial Inserts the Clipboard contents as a linked object, embedded object, Edit menu AltE, S
or other format
EditRedo Redoes the last action that was undone Standard toolbar Alt + Shift + Backspc
EditRedoOrRepeat Repeats the last command, or redoes the last action that was Edit menu F4
undone (unfortunately, doesn’t work for as many commands in
Word 2000 as in Word 97 and below, but this is still one of Word’s
most useful shortcuts, if not the most useful)
EditReplace Finds the specified text or the specified formatting and replaces it Edit menu Ctrl+H
EditSelectAll Selects the entire document Edit menu Ctrl+A
EditUndo Reverses the last action Edit menu & Standard Ctrl+Z
toolbar
EndOfColumn Moves to the last cell in the current table column Alt + PageDn (to select to
end of column, use Alt +
Shift + PgDn)
EndOfDocExtend Extends the selection to the end of the last line of the document Ctrl+Shift+End
EndOfDocument Moves the insertion point to the end of the last line of the document Ctrl+End
EndOfLine Moves the insertion point to the end of the current line End
EndOfLineExtend Extends the selection to the end of the current line Shift+End
EndOfRow Moves to the last cell in the current row Alt+End




Word Command

Version

Shortcut

EndOfWindow

Description

Moves the insertion point to the end of the last visible line on the
screen

Alt + Ctrl + PgDn

EndOfWindowExtend

Extends the selection to the end of the last visible line on the screen

Shift + Alt + Ctrl + PgDn

ExtendSelection

Turns on extend selection mode and then expands the selection
with the direction keys

Status bar (double-click)

F8 (press Esc to turn off)

FileClose

Closes all of the windows of the active document (this command
does intercept the menu command, unless the Shift key is held
down; and the x close button. But it does not intercept any of the
keyboard shortcuts, which are assigned to DocClose for reasons that
will forever remain a mystery. Using an AutoClose macro is a better
way of intercept documents closing).

File menu

FileCloseAll

Closes all of the windows of all documents

File menu with Shift key
held down

FileCloseOrExit

Closes the current document, or if no documents are open, quits
Word. Horrible command, as it makes it a long winded business to
quit Word. But there’s a simple solution - assign Alt+F4 to FileExit
instead.

<9>

Alt + F4 (<9>)

FileCloseOrCloseAll

Performs FileClose or, if the shift key is down, FileCloseAll (this
command does intercept the menu command and the x close button
but does not intercept any of the keyboard shortcuts. Using an
AutoClose macro is a better way of intercept documents closing).

File menu

FileExit

Quits Microsoft Word and prompts to save the documents (does
intercept the menu item, but not the keyboard shortcut, or the x
button. An AutoExit macro is usually a better way of intercepting
this).

File menu

Alt + F4 (Word 97)




Word Command

Description

Version

Shortcut

FileNew Creates a new document or template (brings up the dialog). Note File menu (but not std NOT Ctrl+N!!
that: Word pretends that Ctrl+N is assigned to FileNew but it isn’t, toolbar)
it's assigned to FileNewDefault You can fix this in Word 2000 by
assigning Ctrl+N to the FileNewDialog command. In Word 97 the
only way to fix it is to create a macro called FileNew (to do this,
press Alt + F8, type "FileNew" without the quotes and Click
"Create". The macro will automatically contain the code needed to
make it work).
FileNewDefault Creates a new document based on the Normal template. Std toolbar Ctrl+N
FileOpen Opens an existing document or template File menu & std toolbar  |Ctrl+O
FilePageSetup Changes the page setup of the selected sections File menu AltF, U
FilePrint Prints the active document (brings up the dialog) File menu Ctrl + P
FilePrintDefault Prints the active document using the current defaults Std toolbar
FilePrintPreview Displays full pages as they will be printed File menu & std toolbar | Ctrl+F2
FileProperties Shows the properties of the active document File menu AltF, 1
FileRoutingSlip Adds or changes the electronic mail routing slip of the active File + Send to menu
document
FileSave FileSave File menu, std toolbar Ctrl+S
FileSaveAll Saves all open files, their attached templates, and any addins that File menu & std toolbar
are loaded, if they have been amended since the last save; with Shift key down
prompting for each one separately
FileSaveAs Saves a copy of the document in a separate file (brings up the File menu AltF, A (or F12)
dialog)
FileSaveAsWebPage Saves a copy of the document in a separate HTML file <9> |File menu
FileSaveHtml Does the same thing as the FileSaveAsWebPage command. In Word Word 97 File menu
97, it intercepts the menu command; in Word 2000, it doesn’t (great
compatibility decision!)
FileSendMail Sends the active document through electronic mail File menu
FileTemplates Changes the active template and the template options Tools menu
FileVersions Manages the versions of a document (use at your peril!) File menu
FixMe Runs Detect and Repair <9> |Help menu
Font Activates the Fonts listbox on the formatting toolbar Formatting toolbar Ctrl+Shift+F




Word Command

Description

Version

Shortcut

FontSizeSelect Activates the Font Size drop-down on the formatting toolbar Formatting toolbar Ctrl+Shift+P
FormatAutoFormat Automatically formats a document (or sometimes, automatically Format menu Alt+ Ctrl + K
screws it up)
FormatBackgroundFillEffect Provides fill effects for the background color (only useful for Format menu
creating web pages, as background colours do not print)
FormatBordersAndShading Changes the borders and shading of the selected paragraphs, table Format menu AltO, B
cells, and pictures
FormatBulletDefault Creates a bulleted list based on the current defaults. Use at your Formatting toolbar
peril - it’s far better to apply styles.
FormatBulletsAndNumbering Creates a numbered or bulleted list (brings up the dialog). Use at Format menu
your peril - it’s far better to apply styles.
FormatChangeCase Changes the case of the letters in the selection Format menu AltO,E
FormatChangeCaseFareast Changes the case of the letters in the selection, in certain language Format menu
versions of Word
FormatColumns Changes the column format of the selected sections (brings up the Format menu AltO,C
dialog)
FormatCombineCharacters “Combines Characters” (doesn’t seem to do anything useful <9> |Word 2000 Extended
though) Formatting toolbar
FormatDropCap Formats the first character of current paragraph as a dropped Format menu AltO,D
capital (must select it first)
FormatEncloseCharacters Enclose characters in a circle (but doesn’t work properly) <9> |Word 2000 Extended
Formatting toolbar
FormatFont Brings up the Format + Font dialog Format menu Ctrl+D
FormatFrame Changes the options for Word frame formatting (meaning “frames” Rt-click on a frame
as in the things that are a bit like textboxes but work better - not
web frames.
FormatHeaderFooterLink Links the current header/footer to the previous section (but does Alt + Shift + R
not intercept the button on the Header Footer toolbar)
FormatNumberDefault Creates a numbered list based on the current defaults (use at your Formatting toolbar
peril - much better to apply styles)
FormatPageNumber Brings up the Page Number Format dialog and applies the settings HeaderFooter toolbar
without inserting a new page number in a frame (so is much more
useful than the menu item)
FormatParagraph Brings up the Format Paragraph dialog Format menu AltO, P




Word Command

Version

Shortcut

Description

FormatPhoneticGuide Inserts a Phonetic Guide field in the active document <9> |Word 2000 Extended
Formatting toolbar
FormatStyle Applies, creates, or modifies styles Format menu AltO,S
FormatTabs Brings up the Format Tabs dialog Format menu AltO, T
FormatTextFlow Changes text flow direction and character orientation in a table cell Rt-click menu
FormatTheme Brings up the dialog to apply a web theme (only useful for web <9> |Format menu
pages)
FormFieldOptions Brings up the dialog to change the options for a form field Forms toolbar
FormShading Changes shading options for the current form Forms toolbar
FrameProperties Changes the Properties of a Web Frame <9> | (Web) Frames toolbar
FrameRemoveSplit Removes the current Web frame <9> [(Web) Frames toolbar
FramesetTOC Create a Web frameset table of content <9> (Web) Frames toolbar
FramesetWizard Turns the current window into a Web frameset <9> |Format menu
FrameSplitAbove <9> (Web) Frames toolbar
FrameSplitBelow Splits the active Web frame, adding the new Web frame below the <9> | (Web) Frames toolbar
current one
FrameSplitLeft Splits the active Web frame, adding the new Web frame to the left off <9> | (Web) Frames toolbar
the current one
FrameSplitRight Splits the active Web frame, adding the new Web frame to the right <9> | (Web) Frames toolbar
of the current one
GoBack Returns to the previous insertion point (goes back to up to 3 points, Shift + F5
then returns to where you started; this is one of the most useful
shortcuts of them all. Also useful when opening a document, if you
want to g straight to where you were last editing it)
GoToHeaderFooter Jumps between Header and Footer HeaderFooter toolbar
GotoNextLinkedTextBox Selects the next linked text box Text box toolbar & rt-click
menu
GotoPrevLinkedTextBox Selects the previous linked text box Text box toolbar & rt-click
menu
GrowFont Increases the font size of the selection Ctrl + >
GrowFontOnePoint Increases the font size of the selection by one point Ctrl +]




Word Command

Description

Shortcut

HangingIndent Increases the hanging indent Ctrl + T (or drag the ruler)
Help Microsoft Word Help Help menu F1
HelpAbout Displays the program information, Word version number and the Help menu

copyright
HelpTool Lets you get help on a command or screen region or examine text Shift + F1

properties
Hidden Makes the selection hidden text (toggle) Ctrl + Shift + H
HyperlinkOpen Connect to a hyperlink’s address Click on it
Indent Moves the left indent to the next tab stop Ctrl + M (or drag the ruler)
InsertAnnotation Inserts a comment Insert menu Alt + Ctrl + M (or Alt I, M)
InsertAutoText Replaces the name of the AutoText entry with its contents F3
InsertBreak Ends a page, column, or section at the insertion point Insert menu Alt1, B
InsertCaption Inserts a caption above or below a selected object Insert menu Alt], C
InsertClipArt Word 97 and below only. Inserts a Microsoft Clip Art Gallery object. Word 97 Insert menu

The Word 2000 menu item does not seem to be interceptable!
InsertColumnBreak Inserts a column break at the insertion point Ctrl + Shift + Return
InsertCrossReference Inserts a cross-reference Insert menu
InsertDatabase Inserts information from an external data source into the active Database toolbar

document
InsertDateField Inserts a date field Alt + Shift + D
InsertDateTime Inserts the current date and/or time into the active document Insert menu
InsertEndnoteNow Inserts an endnote reference at the insertion point without Alt+ Ctrl + D

displaying the dialog
InsertField Inserts a field in the active document Insert menu AltI, F
InsertFieldChars Inserts an empty field with the enclosing field characters Ctrl+F9
InsertFile Inserts the text of another file into the active document Insert menu AltI, L
InsertFootnote Inserts a footnote or endnote reference at the insertion point Insert menu AltN
InsertFootnoteNow Inserts a footnote reference at the insertion point without displaying Alt+ Ctrl + F

the dialog




Word Command

Description

Shortcut

InsertFrame Inserts an empty frame or encloses the selected item in a frame (well Forms toolbar
worth adding to the Insert menu)

InsertHyperlink Insert Hyperlink Insert menu Ctrl + K

InsertindexAndTables Inserts an index or a table of contents, figures, or authorities into the Insert menu AltI, D
document

InsertListNumField Inserts a ListNum Field Alt+Ctrl + L

InsertMergeField Brings up a dialog to insert a mail merge field at the insertion point. Alt + Shift + F
(It does not intercept the button on the Mail merge. toolbar)

InsertNumberOfPages Inserts a number of pages field HeaderFooter toolbar

InsertObject Inserts an equation, chart, drawing, or some other object Insert menu

InsertOCXButton Inserts a Button Control Control toolbox toolbar

InsertOCXCheckbox Inserts a Checkbox Control Ditto

InsertOCXDropdownCombo Inserts a Combobox Control Ditto

InsertOCXImage Inserts an Image Control Ditto

InsertOCXLabel Inserts a Label Control Ditto

InsertOCXListBox Inserts a Listbox Control Ditto

InsertOCXOptionButton Inserts a RadioButton Control Ditto

InsertOCXScrollbar Inserts a Scrollbar Control Ditto

InsertOCXSpin Inserts a Spin Control Ditto

InsertOCXTextBox Inserts a Text Box Control Ditto

InsertOCXToggleButton Inserts a Toggle Button Control Ditto

InsertPageBreak Inserts a page break at the insertion point Ctrl + Return

InsertPageField Inserts a page number field HeaderFooter toolbar Alt + Shift + P

InsertPicture Inserts a picture from a graphics file Insert menu

InsertSpike Empties the spike AutoText entry and inserts all of its contents into Ctrl + Shift + F3
the document

InsertSubdocument Opens a file and inserts it as a subdocument in a master document Outlining toolbar
(but don’t use Master documents!)

InsertSymbol Inserts a special character Insert menu

InsertTimeField Inserts a time field Alt + Shift + T

Italic Makes the selection italic (toggle) Formatting toolbar Ctrl +1

JustifyPara Aligns the paragraph at both the left and the right indent Formatting toolbar Ctrl +]

LeftPara Aligns the paragraph at the left indent Formatting toolbar Ctrl + L
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Shortcut

LineDown Moves the insertion point down one line Down arrow
LineDownExtend Extends the selection down one line Shift + down arrow
LineUp Moves the insertion point up one line Up arrow
LineUpExtend Extends the selection up one line Shift + up arrow
LockDocument Toggles the file lock state of a Master Document (but avoid using Outlining toolbar

Master Documents)
LockFields Locks the selected fields to prevent updating Ctrl + F11
Magnifier Toggles between Edit mode and Zoom-in zoom-out mode Print Preview toolbar
MailMerge Merges a mail merge document with its datafile to the printer, a Mail merge toolbar

new document, fax or email
MailMergeCheck Checks for errors in a mail merge Alt + Shift + K
MailMergeCreateDataSource Creates a new mail merge data source Mail merge toolbar
MailMergeDataForm Edits a list or table in a form Database toolbar
MailMergeEditDataSource Lets you edit a mail merge data source Mail merge toolbar Alt+Shift+E
MailMergeEditMainDocument Switches to a mail merge main document Database toolbar
MailMergeFindRecord Finds a specified record in a mail merge data source Mail merge toolbar
MailMergeFirstRecord Displays the first record in the active mail merge data source (if The Mail merge toolbar

View Merged Data button is on)
MailMergeGoToRecord Displays the specified record in the active mail merge data source (if] Mail merge toolbar

The View Merged Data button is on)
MailMergeHelper Prepares a main document for a mail merge Tools menu & Mail merge

toolbar

MailMergeLastRecord Displays the last record in the active mail merge data source (if The Mail merge toolbar

View Merged Data button is on)
MailMergeToDoc Collects the results of the mail merge in a document Mail merge toolbar Alt + Shift + N
MailMergeToPrinter Sends the results of the mail merge to the printer Mail merge toolbar Alt Shift + M
MailMergeViewData Toggles between viewing merge fields and actual data Mail merge toolbar
MarkCitation Marks the text you want to include in the table of authorities Alt + Shift +1
MarkIndexEntry Marks the text you want to include in the index Alt + Shift + X
MarkTableOfContentsEntry Inserts a TC field (but it is far better to use Heading Styles to Alt + Shift + O

generate your Table of Contents instead)
MenuMode Makes the menu bar active Alt or F10
MergeSubdocument Merges two adjacent subdocuments into one subdocument (but Outlining toolbar

avoid using Master Documents)
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Shortcut

MicrosoftAccess Starts or switches to Microsoft Access Microsoft toolbar
MicrosoftExcel Starts or switches to Microsoft Excel Microsoft toolbar
MicrosoftFoxPro Starts or switches to Microsoft FoxPro Microsoft toolbar
MicrosoftMail Starts or switches to Microsoft Mail Microsoft toolbar
MicrosoftOnTheWeb1 through Takes you to various locations on the MS site. Word 97 Help menu
MicrosoftOnTheWeb17
MicrosoftPowerPoint Starts or switches to Microsoft PowerPoint Microsoft toolbar
MicrosoftProject Starts or switches to Microsoft Project Microsoft toolbar
MicrosoftPublisher Starts or switches to Microsoft Publisher Microsoft toolbar
MicrosoftSchedule Starts or switches to Microsoft Schedule+ Microsoft toolbar
MicrosoftScriptEditor Starts or switches to Microsoft Development Environment <9> Alt + Shift + F11
application, allowing you to view the HTML/ XML source code that
would be behind the document if it were in .htm format (or that is
behind it if it already is in .htm format).
MicrosoftSystemInfo Execute the Microsoft System Info application Alt + Ctrl + F1
MoveText Moves the selection to a specified location without using the F2
clipboard (press Return to execute the more)
NextCell Moves to the next table cell Tab
NextField Moves to the next field F11
NextMisspelling Find next spelling error Alt + F7
NextObject Moves to the next object on the page Alt + down arrow
NextWindow Switches to the next document window, equivalent to selecting a Ctrl + F6
document from the Window menu.
NormalStyle Applies the Normal style Ctrl+Shift+N
OfficeOnTheWeb Word 2000 Help menu - takes you to Microsoft’s Office Update <9> |Help
page.
OpenOrCloseUpPara Sets or removes extra spacing above the selected paragraph Ctrl +0
OpenSubdocument Opens a subdocument in a new window. (But avoid using Master Double-clicking the little

Documents)

icon to the left of the first
heading in a
subdocument, when in
Master Document view
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OtherPane Switches to another window pane in Normal View (for instance, if F6
you have if you have a Footnotes pane open in Normal view and
want to switch to the main document and back without closing the
pane).
OutlineCollapse Collapses an Outline in Outline View by one level Outlining toolbar Alt+ _
OutlineDemote Demotes the selected paragraphs one heading level Outlining toolbar Alt+Shift+rt arrow
OutlineExpand Expands an Outline in Outline View by one level Outlining toolbar Alt + +
OutlineMoveDown Moves the selection below the next item in the outline Outlining toolbar Alt+Shift+down arrow
OutlineMoveUp Moves the selection above the previous item in the outline Outlining toolbar Alt+Shift+up arrow
OutlinePromote Promotes the selected paragraphs one heading level Outlining toolbar Alt+Shift+left arrow
OutlineShowFirstLine Toggles between showing the first line of each paragraph only or Outlining toolbar Alt + Shift + L
showing all of the body text in the outline
OutlineShowFormat Toggles the display of character formatting in outline view Outlining toolbar
Overtype Toggles the typing mode between replacing and inserting Ins
PageDown Moves the insertion point and document display to the next screen PgDn
of text
PageDownExtend Extends the selection and changes the document display to the next Shift+ PgDn
screen of text
PageUp Moves the insertion point and document display to the previous PgUp
screen of text
PageUpExtend Extends the selection and changes the document display to the Shift + PgUp
previous screen of text
ParaDown Moves the insertion point to the beginning of the next paragraph Ctrl + down arrow
ParaDownExtend Extends the selection to the beginning of the next paragraph Shift + Ctrl + down arrow
ParaUp Moves the insertion point to the beginning of the previous Ctrl + up arrow
paragraph
ParaUpExtend Extends the selection to the beginning of the previous paragraph Shift + Ctrl + up arrow
PasteFormat Applies the previously copied formatting to selection Ctrl+Shift+V
PrevCell Moves to the previous table cell Shift + Tab
PrevField Moves to the previous field Shift + F11
PrevObject Moves to the previous object on the page Alt + up arrow
PrevWindow Switches back to the previous document window Ctrl + Shift + F6
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Shortcut

RemoveCellPartition Displays the “Eraser” tool so that you can merge table cells by Tables and Borders toolbar
“rubbing out” the cell partitions (it’s much simpler to select Table +
Merge cells though!)
RemoveSubdocument Merges the contents of the selected subdocuments into the master Outlining toolbar
document that contains them (but don’t use this command, as it
often corrupts the document)
RepeatFind Repeats Go To or Find to find the next occurrence Sfift+F4
ResetChar Makes the selection the default character format of the applied style Ctrl+Spacebar
ResetPara Makes the selection the default paragraph format of the applied Ctrl+Q
style
RightPara Aligns the paragraph at the right indent Formatting toolbar Ctrl +R
SelectDrawingObjects Use to select drawing objects -- drag to create a rectangle enclosing Drawing toolbar
the objects
SendToFax Send this document to fax File menu
SetDrawingDefaults Changes the default drawing object properties to those of the Drawing toolbar
currently selected object
ShowAll Shows/hides all nonprinting characters Standard toolbar Ctrl +*
ShowAllHeadings Displays all of the heading levels and the body text in Outline View Outlining toolbar Alt + Shift + A
ShowHeadingl Displays the level 1 headings only in Outline View Outlining toolbar
ShowHeading?2 Displays the level 1 and 2 headings in Outline View Outlining toolbar
ShowHeading3 Displays the level 1 through 3 headings in Outline View Outlining toolbar
ShowHeading4 Displays the level 1 through 4 headings in Outline View Outlining toolbar
ShowHeading5 Displays the level 1 through 5 headings in Outline View Outlining toolbar
ShowHeading6 Displays the level 1 through 6 headings in Outline View Outlining toolbar
ShowHeading? Displays the level 1 through 7 headings in Outline View Outlining toolbar
ShowHeading8 Displays the level 1 through 8 headings in Outline View Outlining toolbar
ShowHeading9 Displays the level 1 through 9 headings in Outline View Outlining toolbar
ShowNextHeaderFooter Shows next section's header/footer in page layout view Header/footer toolbar
ShowPrevHeaderFooter Shows previous section's header/footer in page layout view Header/footer toolbar
ShrinkFont Decreases the font size of the selection Ctrl + <
ShrinkFontOnePoint Decreases the font size of the selection by one point Ctrl + [
SmallCaps Makes the selection small capitals (toggle) Ctrl + Shift + K
SpaceParal Sets the line spacing to single space Ctrl +1
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Shortcut

SpaceParal5 Sets the line spacing to one-and-one-half space Ctrl +5
SpacePara2 Sets the line spacing to double space Ctrl +2
Spike Deletes the selection and adds it to the “Spike” AutoText entry Ctrl + F3
(which allows you to move text and graphics from nonadjacent
locations)
SplitSubdocument Splits the selected part of a subdocument into another subdocument Outlining toolbar
at the same level (but avoid using Master Documents)
StartOfColumn Moves to the first cell in the current column Alt + PgUp
StartOfDocExtend Extends the selection to the beginning of the first line of the Ctrl+Shift+Home
document
StartOfDocument Moves the insertion point to the beginning of the first line of the Ctrl +Home
document
StartOfLine Moves the insertion point to the beginning of the current line Home
StartOfLineExtend Extends the selection to the beginning of the current line Shift+Home
StartOfRow Moves to the first cell in the current row Alt+Home
StartOfWindow Moves the insertion point to the beginning of the first visible line on Alt+Ctrl+PgUp
the screen
StartOfWindowExtend Extends the selection to the beginning of the first visible line on the Shift+ Alt+Ctrl+PgUp
screen
Style Activates the Style drop-down on the Formatting toolbar Strl + Shift + S
Subscript Makes the selection subscript (toggle) Ctrl + =
Superscript Makes the selection superscript (toggle) Ctrl + +
SymbolFont Applies the Symbol font to the selection Ctrl + Shift + Q
TableAutoFormat Applies a set of formatting to a table Table menu, Tablesand |Alt A, F
Borders toolbar
TableDeleteColumn Deletes the selected columns from the table Word 2000 Table menu
TableDeleteGeneral Deletes the selected cells from the table Word 97 Table menu
TableDeleteRow Deletes the selected rows from the table Word 2000 Table menu
TableFormatCell Brings up the Table + Cell Height and width dialog (even in Word Word 97 Table menu
2000) ; IN Word 97, intercepts the menu command
TableFormula Inserts a formula field into a table cell Table menu
TableGridlines Toggles table gridlines on and off Table menu
TableHeadings Toggles table headings attribute on and off Table menu Alt A, H




Word Command
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Shortcut

Description

TableInsertGeneral Context-sensitive. Inserts a table, row, column or cell, depending on Standard toolbar, and
what is selected at the time Word 97 Table menu
TableInsertRowAbove Inserts one or more rows above the current one <9> [Word 2000 Table menu
TableMergeCells Merges the selected table cells into a single cell Table menu
TableSelectCell Selects the current cell in a table <9> [Word 2000 Table menu
TableSelectColumn Selects the current column in a table Table menu Alt + click (Alt + drag to
select several)
TableSelectRow Selects the current row in a table Table menu Click in left margin
TableSelectTable Selects an entire table Table menu Alt + double-click
TableSort Rearranges the selection into a specified order Table menu
TableSortAToZ Sorts records in ascending order (A to Z) Database toolbar
TableSortZToA Sorts records in descending order (Z to A) Database toolbar
TableSplit Inserts a paragraph mark above the current row in the table Table menu
TableSplitCells Splits the selected table cells Table menu
TableToOrFromText Converts the text to a table or vice versa Word 97 Table menu

TableUpdateAutoFormat

Updates the table formatting to match the applied Table
Autoformat settings

Alt+ Ctrl + U

Documents!). The toolbar button’s tooltip says “Collapse” or
“Expand Subdocuments”.

TextBoxLinking Creates a forward link to another text box Text box toolbar & rt-click
menu
TextBoxUnlinking Breaks the forward link to another text box Text box toolbar & rt-click
menu
TextFormField Inserts a text form field Forms toolbar
ToggleFieldDisplay Shows the field codes or the results for the selection (toggle) Rt-click menu Shift + F9 (Alt + F9 toggles
all field codes on or off)
ToggleFormsDesign Enables forms using OLE controls to be created. However, OLE Control toolbox toolbar
controls make documents horrendously slow.
ToggleFull Toggles full screen mode on/ off View menu
ToggleHeaderFooterLink Links or unlinks this header/footer to or from the previous section Header/footer toolbar
ToggleMainTextLayer Toggles showing the main text layer when in a Header or footer Header/footer toolbar
ToggleMasterSubdocs Switches between hyperlinks and subdocuments (but avoid Master Outlining toolbar




Word Command

Description

Version

Shortcut

ToolsAddRecordDefault

Adds a record to a database (or a row to the end of a table)

Database toolbar

ToolsAutoCorrect Displays the Autocorrect tab of the Tools Autocorrect dialog (does Tools menu
not intercept the menu command).

ToolsAutoManager Displays the Tools + Autocorrect dialog Tools menu

ToolsAutoSummarize Automatically generates a summary of the active document Tools menu

ToolsCompareVersions Compares the active document with an earlier version (Tools + Tools menu
Compare Documents)

ToolsCustomize Allows you to customizes the Word user interface (menus, Tools menu Alt T, C
keyboard and toolbars) and store the customizations in a template
(defaults to Normal.dot, so be careful!)

ToolsCustomizeAddMenuShortcut Allows you to copy an item from a toolbar to the main menu, or to Alt + Ctrl + =
copy a nested menu item to its main menu. However, it works with (The equals sign on the

some buttons and not others, and it does not give you any control
over where the item gets added (that's all "taken care of" for you by
Microsoft). Using Tools + Customise works much better. But for the
record, an example of the former is: press Alt+Ctrl+=, then click on
the "Insert Microsoft Excel Worksheet" menu on the standard
toolbar. You'll find that the button has now been added to the Insert
menu. An example of the latter: press Alt+Ctrl+= and click on Insert
+ Picture + From File. The button gets inserted (without being
nested) on the main Insert menu. But you can do this far more
straightforwardly and with much more control if you use Tools +
Customize instead.

main keyboard, not the one
on the numeric keypad)

ToolsCustomizeRemoveMenuShortcut

Allows you to delete a menu sub-item without having to use the
Customize dialog.Does not wirh toolbar buttons (you can use Alt- +
drag to remove those). Press Alt+Ctrl+Hyphen, and the mouse
cursor changes to a thick black bar. Pull down a menu and click on
the item you want to remove. But be extremely careful - it's easy to
remove the wrong thing by mistake! The main reason it can be
useful is that it's the only way to remove an individual item from
the Most Recently Used Files list without resorting to a macro. But
the macro-based solution for that is much easier - see:
www.mvps.org/word/FAQs/Customization/ OpenMostRecentlyU
sed.htm for details

Alt + Ctrl +-

(The hyphen on the main
keyboard, not the one on the
numeric keypad)




Word Command

ToolsCustomizeKeyboard

Description
Customizes the Word key assignments

Version

Tools + Customize dialog,
Keyboard button

Shortcut

ToolsEnvelopesAndLabels

Creates or prints an envelope, a label, or a sheet of labels

Tools menu

ToolsHyphenation Changes the hyphenation settings for the active document Tools menu (under
Language!)
ToolsLanguage Changes the language formatting of the selected characters Tools menu (Language +
Set Language)
ToolsMacro Runs, creates, deletes, or revises a macro Tools menu (Macro + Alt + F8
Macros)
ToolsManageFields Adds or deletes a field from a database (in English that means it Database
adds or removes columns from the current table)
ToolsOptions Changes various categories of Word for Windows options Tools menu
ToolsProofing Checks the spelling and grammar in the active document Tools menu F7
ToolsProtectUnprotectDocument Sets protection for the active document Tools menu
ToolsRecordMacroToggle Turns macro recording on or off Visual Basic toolbar
ToolsRemoveRecordDefault Removes a record from a database (or in English, deletes the current Database toolbar
row from a table)
ToolsReviewRevisions Displays the Accept or Reject changes dialog Tools menu
ToolsRevisionMarksToggle Toggles track changes for the active document Ctr.l + Shift + E
ToolsShrinkToFit Attempts to make the document fit on one less page Print Preview toolbar
ToolsThesaurus Finds a synonym for the selected word Tools menu (under Shift + F7
Language)
ToolsWordCount Displays the word count statistics of the active document Tools menu
TopAlign Aligns cell content to the top of cell - very useful and unfortunately, Word 97 right-click menus

not accessible via the default Word 2000. menus. It is well worth
replacing the Word 2000 Cell Alignment buttons on the right-click
table menus and on the Tables and Borders toolbar, with
BottomAlign, CenterAlign and TopAlign buttons. The Word 2000
buttons, unfortunately, apply manual left center or justified
paragraph formatting to the text in the cells, which is the last thing
you would ever want to happen!

and Word 97 Tables and
Borders menu




Word Command Description Version Shortcut
TopCenterAlign Aligns cell content to the top-center of cell (yuckk!!) <9> |Word 2000 right-click
menus and Word 2000
Tables and Borders menu
TopLeftAlign Aligns cell content to the top-left of cell (yuckk!!) <9> |Word 2000 right-click
menus and Word 2000
Tables and Borders menu
TopRightAlign Aligns cell content to the top-right of cell (yuckk!!) <9> |Word 2000 right-click
menus and Word 2000
Tables and Borders menu
Underline Formats the selection with a continuous underline (toggle) Formatting toolbar Ctrl+U
UnHang Decreases the hanging indent Ctrl + Shift + T (or drag the
ruler)
UnIndent Moves the left indent to the previous tab stop Ctrl + Shift + M (or drag the
ruler)
UnlinkFields Permanently replaces the field codes with the results Ctrl+Shift+F9
UnlockFields Unlocks the selected fields for updating Ctrl + Shift + F11
UpdateFields Updates and displays the results of the selected fields F9
UpdateSource Copies the modified text of a linked file back to its source file Ctrl + Shiift + F7
ViewAnnotations Show or hide the comment pane View menu (View + Hover over comment
Comments)
ViewBorderToolbar Shows or hides the Tables and Borders toolbar Standard toolbar (but you
can right-click on any
toolbar to select which
toolbars should be visible)
ViewCode View Code for Selected Control Control toolbox toolbar
and right-click menu
ViewDocumentMap Toggles state of the Document Map (warning - the Document Map View menu and Standard
has a way of destroying documents; Outline View is much safer). toolbar




Word Command

Shortcut

Description

ViewDrawingToolbar Shows or hides the Drawing toolbar Standard toolbar (but you
can right-click on any
toolbar to select which
toolbars should be visible)
ViewEndnoteArea If in Normal View, opens a pane for viewing and editing the Dbl-click the endnote

endnote (toggle). If in Page/Print Layout View, switches from the
body text to the endnote or vice versa

reference

ViewEndnoteContNotice

Opens a pane for viewing and editing the endnote continuation
notice

Endnote pane (in Normal
View)

ViewEndnoteContSeparator

Opens a pane for viewing and editing the endnote continuation
separator

Endnote pane (in Normal
View)

ViewEndnoteSeparator

Opens a pane for viewing and editing the endnote separator

Endnote pane (in Normal
View)

ViewFieldCodes

Shows the field codes or results for all fields (toggle)

At +F9

ViewFootnoteArea

If in Normal View, opens a pane for viewing and editing the
footnote (toggle). If in Page/Print Layout View, switches from the
body text to the footnote or vice versa.

Dbl-click the footnote
reference

ViewFootnoteContNotice

Opens a pane for viewing and editing the footnote continuation
notice

Footnote pane (in Normal
View)

ViewFootnoteContSeparator

Opens a pane for viewing and editing the footnote continuation
separator

Footnote pane (in Normal
View)

ViewFootnotes If in Normal View, opens a pane for viewing and editing footnotes View menu AltV,F

and endnotes (toggle). If in Page/Print Layout View, switches from

the body text to the footnotes/endnotes or vice versa.
ViewFootnoteSeparator Opens a pane for viewing and editing the footnote separator Footnote pane (in Normal

View)

ViewHeader Displays header in page layout view View menu AltV, H
ViewNormal Changes the editing view to normal view View menu AltV, N (or Alt + Ctrl + N)
ViewOnline Displays the document as it would appear in IE5 if saved as an htm Word 97 View menu

file. Intercepts the Word 97 menu command but not the Word 2000
one (brilliantly thought out compatibility strategy!)




Word Command

Version

Shortcut

Description

ViewOutline Displays a document's outline View menu AltV, O (or Alt + Ctrl + O)
ViewPage Displays the page more-or-less as it will be printed, and allows View menu AltV, P (or Alt + Ctrl + P)
editing (In Word 2000 the menu item is called Print Layout, but
fortunately the command hasn’t changed.
ViewSecurity Displays the Security settings dialog <9> |Word 2000 Tools menu
(under Macro)
ViewToggleMasterDocument Switches between Outline and Master Document views (but avoid Outlining toolbar
using Master Documents)
ViewVBCode Shows the VB editing environment (Tools + Macro + Visual Basic Tools menu Alt + F11
Editor)
ViewWeb Displays the document as it would appear in IE5 if saved as an htm <9> |Word 2000 View menu
file. Intercepts the Word 97 menu command but not the Word 2000
one (brilliantly thought out compatibility strategy!)
ViewZoom Displays a dialog to scale the editing view View menu
WebAddToFavorites Add to Favourites Web toolbar
WebGoBack Backward hyperlink (useful if you clicked on a page number Web toolbar Alt + left arrow
hyperlink in the table of contents and then want to return to the
TOCQ)
WebGoForward Forward hyperlink Web toolbar Alt + rt arrow
WebHideToolbars Hide other toolbars Web toolbar
WebOpenInNewWindow Open in New Window Web toolbar
WebStopLoading Stop current jump Web toolbar
WindowArrangeAll Arranges windows as non-overlapping tiles Window menu AltW, A
WindowNewWindow Opens another window for the active document Window menu
WordLeft Moves the insertion point to the left one word Ctrl + left arrow
WordLeftExtend Extends the selection to the left one word Shift + Ctrl + left arrow
WordRight Moves the insertion point to the right one word Ctrl + rt arrow
WordRightExtend Extends the selection to the right one word Shift + Ctrl + rt arrow
WordUnderline Underlines the words but not the spaces in the selection (toggle) Ctrl + Shift + W




